
The season for vacations,
beaches, barbeques, etc., also
means a trek to Beantown for a
number of our members.
MacWorld Expo is an opportu-
nity to not only see where the
Mac platform is going, but also
exchange opinions with other
user group members on how we
can improve our organization.
Some thoughts on this subject:

When I joined LIMac ten
years back, the annual dues
were $24, the same as they are
today. I think very few user groups, or any
other organization, can make a similar claim. 
As we think of upgrading our projection system
and the computer system, some members have
suggested that we should consider a dues
increase. This subject will be discussed at a
board meeting, before bringing it up at the
general meeting. We will also be discussing
ideas on having a fund-raiser to improve our
financial condition. If you have any thoughts
on this subject, please let me or any other
board member know.

Besides dues increase, there are a number of
ways our members can help in improving our
cash flow. If you know a Mac user, who is not a

member, please invite them to
attend our meeting. LIMac will
be conducting a big member-
ship drive in September by
writing to over 3000 MacWorld
subscribers on Long Island
regarding the benefits of our
group.

The raffle chances taken by
our members at our meetings
are an important source of 
revenue. I would like to take
this opportunity to thank Bill
Medlow for his tireless efforts 

to get raffle prizes from different vendors.
Please try to take as many raffle chances as 
possible. If you are in a position to obtain raffle
prizes, please let Bill know. We had recently
talked about the electronic distribution of this
newsletter. While we do not intend to inconve-
nience anyone, we can incur savings if a large
number of our members agree to take the
Forum electronically.

Though the Mac platform has experienced
problems and doubts over the past 18 months,
our membership strength has remained steady.
It is now time to increase the membership
count as well as our cash flow. I welcome your
thoughts on these subjects. l – Balan Nagraj
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President’s Remarks

July’s Meetings

The LIMac Flea Market is Coming!
Yep, that’s right. Friday, August15th. Mark it on your calendar.

General Meeting: Friday, July 11, 7:00 P.M.
Don Hennessy will demonstrate a Camcorder
video with an 840Quad using QuickTime. 
Bradley Dichter will  create a Web page.
Ed SIG:
There will be no meetings for July and August.
Beginners SIG: Friday, July 18, 7:00 P.M.
The topic will be Inside Your System.

DTP SIG: 
There will be no meetings for July or August.
Internet SIG: 
There will be no meeting in July.

LIMac Meetings, unless otherwise noted, are held at the New
York Institute of Technology (Building. 500), at Northern
Boulevard, Old Westbury. To see if school is open in bad 
weather, call (516) 686-7789.
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LIMac has been 
serving Macintosh
users on Long Island
since 1984, when the
Mac was introduced.
Annual dues for 
membership is $24.
First meeting is free.
For information, you
can contact any of 
the following:

Membership
Alan Gordon
(516) 538-7013
akgmac@villagenet.
com

Public Domain
Software
Helen and 
Sheldon Gross
(212) 799-5655
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Technical Advice
Bradley Dichter
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It is now time to
increase the 

membership count 
as well as our cash
flow. I welcome your
thoughts on these 

subjects.
Balan Nagraj
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Getting in a Dither
About Printing?
By Phil Caulknis
Let’s take a look at the

printer you have hooked up to your mac. If it’s a
laser printer or Black & White Ink-Jet, it can only
place one color (Black) on the page. If it is a
color Ink-jet, it can only put 3 or 4 colors on the
page. Yet printer manuals for black and white

printers will tell you that they can print from 16
to 64 shades of grey and that color printers can
produce millions of colors. A quick look at any
pictures that you’ve printed will prove that the
manuals are not lying. They can and do produce
many shades of grey and millions of colors.

Printers achieve this feat through a process
called dithering. A basic understanding of how
your printer uses dithering can help you get

better results the next time you print a grey-
scale or color picture.

The word dither means to vacillate or 
alternate between two positions. Thus, when a
national leader dithers it is not generally 
considered to be a good thing. When a printer
dithers it is creating an alternating pattern of
dots that fool your eye and brain into perceiving
a shade of color that lies somewhere between.

For example, take a careful look at a black
and white newspaper photo. Use a magnifying
glass if you have one. The entire picture is 
composed of tiny black dots. Dark areas have a
very dense pattern of dots and lighter areas
have fewer, more widely spaced dot patterns.
This is the simplest form of dithering. Even
glossy black and white magazine photos use
this method. The dot patterns are simply much

Balan Nagraj
President
Balan448@aol.com

PageMaker 6.5 Reviewed Technical Corner
This review is a summary of my 
presentation of PageMaker 6.5 at
our May general meeting, when I
demonstrated the new features of

this version. It is a substantial upgrade and, I
think, a must for any PageMaker user. Adobe’s
claim that it takes you beyond paper publishing
is fairly accurate.

The first thing you notice is the revamped
interface. Adobe has made it similar to their
other main DTP applications: Illustrator &
Photoshop. Some keyboard shortcuts and menu
items have been changed to achieve this 
consistency. I liked the tabbed palettes feature,
familiar to users of Illustrator & Photoshop. You
can customize the palettes by regrouping, 
collapsing, etc. The layers palette, again similar
to the other two programs, is extremely useful
when working in a complex layout with over-
lapping objects. Having previously struggled
through selecting objects that overlap in a 
document, I find this feature a real time-saver.

Frames, which are similar to the picture and
text boxes in QuarkXPress, is new to
PageMaker. These frames are placeholders for
text and graphics useful in creating structured
documents. You can change the stroke and fill
pattern of these frames. However, unlike
QuarkXPress, you cannot have multiple
columns of text in a frame. The Multiple
Master Pages feature, introduced with version
6.0 has been improved. The tabbed Multiple
Masters Page palette makes it easy to create,
modify and apply master pages.

When a PageMaker document designed for
print, has to be published on the ubiquitous
WWW, you may have to change the layout and
resize the objects. The Adjust Layout feature,
can do this automatically, based on their rela-
tionship to page edges and guides. Hyperlinks,
which facilitate navigating within a document
or even to the WWW, is another new feature.
These links are maintained when you export a
PM publication to HTML or PDF. PageMaker
now offers the ability to export the document
to these emerging formats. 

Over the next few months, we will be
exploring the Adjust Layout and Hyperlink 
features. l

| Previously, you said that to switch between
two printers, one that requires AppleTalk
and the other that doesn’t, without restart-
ing, requires Open Transport. I installed it,
but whenever I enter, then exit my browser
(Netscape 2.0.2), the memory was not freed
up. America Online does the same. I don’t
know what version of Open Transport I
have, and I did not use OT/PPP. Do you
think that will solve the problem?
I would imagine you need to update to Open
Transport 1.1.2. It comes as a separate 4-disk
set. Netscape is now at 3.0.1 and 4.0 is going to
be released by the time you read this. I prefer
to use OT/PPP, but in your case, a non-Power
Mac, it’s not required. Netscape 2.0.2 and AOL
are not Open Transport savvy. Netscape
Navigator 3.0.1 is OT friendly. System 7.6 would
not help here either. Your memory problems
are due to either a corrupted System or a con-
flicting extension or your actions. When you
run Program A and then Program B, then quit
out of A, you leave a hole in your memory map
that can’t be used until you quit of out B. If
you were to use Connectix’s RAM Doubler, it’s
memory management is better than Apple’s,
and you would be much less effected by
memory fragmentation. It would still happen,
but it would be minimized. You will eventually
have to restart to free up the memory. Your
best solution regarding the printers and
AppleTalk on/off state would be to get the
AppleTalk adapter for the color printer and
leave AppleTalk on. America Online 3.0 final
version includes a small extension called
OpenOT for 68K users using the TCP/IP pro-
tocol when AppleTalk is inactive. The TCP/IP
network protocol is used with AOL 3.0 and
with Navigator or any Internet access software.
If you’re running System 7.5.5 or later, watch
out for the OpenOT. It is a background applica-
tion (type appe) and needs to have it’s memory
adjusted using the technique covered in earlier
columns. Make sure you have OpenOT enabled,
because you will need it when you turn
AppleTalk off. (BTW-There is a later version of
AOL 3.0 that includes a slightly newer browser.
AOL 3.0’s browser is based on Microsoft
Internet Explorer 2.0) You will find, as time
goes by, that more and more software needs
special hacks to work on the non-Power Mac
models. You’re finding some of them now. I

ClarisWorks 4.0:
Banners.
It’s a simple process
to create multipage
banners and posters
in ClarisWorks.
Create a new drawing
document and select
the Format>
Document… menu
command. Edit the
dialog to specify the
requisite number of
pages across and
down, then zoom out
to work on the whole
spread at once. When
you print, the pages
will be laid out, ready
to assemble into the
finished banner.

TIP!
Microsoft Word 6:
Word count.
Documents often
have precise word
limits, requiring
editing specific 
sections. To count the
words in a portion of
a document, select
the text (click-drag
from start to end)
and choose the 
Tools >Word Count… 
command. Place the
cursor between the
two letters you wish
to kern, then select
that menu command.

TIP!



recommend people to buy Power Macs to
avoid these modern problems and sell your old
68K Macs to people running exclusively with
old software.
| PrintMaster Gold redraws the screen when-
ever you do something, and is really slow on
my Performa 631CD. My Mac does not
come with a math coprocessor. Would it
help to replace the CPU with one that does?
No. Most programs of that sort do not take
advantage of a math coprocessor. It could pos-
sibly be the program just needs more memory
allocated to it or try running it with 256 colors
instead of thousands. Your problem is the 
program was written badly, and is now discon-
tinued. It was never made to be Power Mac
native, so it would be slow even if you got a
Power Mac. I would dump it and move on to
something better. Maybe an old copy of
PageMaker might be for sale at our August flea
market.
| I understand that if you delete the Global
History file from the Netscape ƒ folder in the
Preferences folder inside the System Folder,
Navigator will work faster.
That is true. You can also speed things up along
these lines by reducing the number of days after
which Followed Links Expire to a smaller
number. Try 2 days. On the same screen, you
can turn off Enable Active Scrolling and Show
ToolTips for faster performance. I would also
suggest Show Toolbar As Text for more live
screen real estate and turn off Show Directory
Buttons under the Options menu. You can also
try setting up a 5.1MB RAM Disk from the
Memory control panel, and setting in the
Network Preferences to use a 5MB cache size
and to use the RAM Disk as the Cache
Directory. Give Netscape 10-14 MB of RAM in
its Get Info window (Memory Requirements:
Preferred Size). Finally, don’t use AOL’s service
to use Netscape. Their use of proxy servers
slows things down. Use a good Internet Service
Provider. Of course a fast Power Mac and an
ISDN connection helps too.
| Does the FPU help in anything, like print
rendering or graphics?
ATM, Photoshop, Illustrator all can take advan-
tage of a math coprocessor. Anything involving
the bezier curves of Postscript and fonts would
benefit, but standard text editing and scrolling

3More Technical Corner
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would not speed up, unless ATM has to render
a new typeface in a scrolled to text area. 3D
work and Photoshop filter operations are helped
the most by a math coprocessor or FPU. The
PowerPC chip family has a built-in FPU.
| Netscape 3 has, Netscape 2 did not have an
option to alert you before you accept a
Cookie. First, what is a Cookie? Is it a self
generating file that I shouldn’t touch? Is
there anything I can do to remove all the
Cookies I have gotten prior to my changing
the setting?
Cookies are small bits of data about you that a
web site has stored in a line entry in your
Magic Cookie file. When you visit a certain site
that may ask your to register for access, your
name and password you gave are entered in the
Magic Cookie for later retrieval when you revisit
the site. The NEW YORK TIMES site is a good
example. If you revisit the site, the browser is
queried and your data is given and processed by
the web server. You will probably be welcomed
back because of Cookie information. The Cookie
information can be temporary. If you were to
shop at on online store, your purchases you
have selected and put in your virtual shopping
basket are entered here and later removed. The
entries in the Magic Cookie file are not date
stamped. You can use the shareware Cookie
Cutter to help edit the file. If you think a
Cookie exists with some private information,
like your Social Security Number or a credit
card number, then you can edit the file and see
for your self. Much of what you will find is in
code, so don’t expect too much. You can trash
the file if you’re not sure. Don’t do it while
you’re running Netscape. The file won’t be very
large, under 1 MB. Netscape 2 made use of
Cookies, but did not alert you about them, so
you may have this file if you’ve browsed a web
page with a cookie monster behind it. ;-)
| I have a SyQuest EZFlyer 230MB drive
from which applications can be run. How
do I install them there?
Insert the disk so it shows up on the desktop.
When the installer for whatever program starts
up, you can select the drive to install into. You
can usually hit the Tab key to switch, or there is
a pop-up menu of available volumes. Some-
times you drag an icon for an installation
package to an icon representing your EZFlyer

finer and tightly spaced. While the printer only
printed black, the alternating pattern of black
dots and white space cause you to see grey.
Color printers use much the same method but
at a more sophisticated level. A color ink-jet
creates a pixel (picture element). It places a
combination of color dots in adjacent positions
to create a specific color. Since there are 
millions of possible combinations of cyan,

magenta, yellow, black and unprinted white
space, the printer is able to fool your eye into
seeing millions of different colors.
How Resolution Affects Dithering
Printers are rated by their dpi (dots per inch). A
printer with a high dpi rating can print dithering
patterns of smaller dots and can thus produce
more convincing shades of grey or color. Areas
that gradually change color will do so more

smoothly and are less likely to show stripes or
banding. Because color printers have to build
pixels they generally print color images at half
the dpi that they can accomplish when printing
black and white. Thus a 600 dpi color inkjet
printer will print black and white images at 600
dpi but will only print color images at 300 dpi.
The best laser printers can currently print at 
resolutions of 1200 to 1800 dpi. The best inkjet

printers tend to print at 600 – 720 dpi (black
and white) resolutions.
Scatter vs. Pattern dithering

When you examine a laser printed image or
a news photo, you will see a checker board style
pattern of dots. At 600 or better dpi, this
method usually works well. At 300 dpi, this
method often produces images where there is
noticeable banding and skin tones often

Startups:
| If you hold down
the Option key while
starting your Mac,
any windows that you
may have left open
when you last shut
down will be closed
automatically.
| If you hold down
the Command key
while starting your
computer, you will
turn off Virtual
Memory.
| Holding down the
Shift key while
starting will disable
your Extensions. If
you press the Shift
key after your
Extensions have
loaded but before
your Desktop
appears, you will 
prevent any items in
your Startup Items
folder from running
without turning off
your Extensions.
| If you hold down
the Space Bar while
starting your Mac,
you will open your
Extensions Manager.
| Hold down the
Command-Option-
Shift-Delete keys just
after you turn on your
Mac to switch to a
different Startup Disk
if one is available.
| The Command-
Option-P-R keys held
down just after
starting your Mac will
zap your PRAM. to
reset your control
panels.
| On a PowerMac,
you can force it to
startup from a
Startup CD by
holding the C key.

TIP!
Automatic Tracing:
Few realize that
Photoshop is better
at tracing around
images than
Illustrator or
Freehand. To trace a
gray-scale image,
press Command-
Option-1 to select
white areas in the
image, then choose
Inverse from the
Select menu to select
the black areas. To
convert the selection
to vector-based
paths, switch to the
Paths palette and
click on the dotted
circle icon. Now you
have a collection of
object oriented
paths. You can export
them for use in
Illustrator or
Freehand by
choosing Paths to
Illustrator from the
Export submenu
under the File menu.

TIP!

Continued on Page 4



disk. Under these circumstances your program
will run off the EZFlyer, but the System will still
be running off the usual hard drive. Many 
programs install a portion of themselves into
the System Folder in various places. If you want
the program to run totally from the EZFlyer,
you would have to install a System Folder onto
the EZFlyer disk, then use the Startup Disk
control panel to select the EZFlyer disk, restart,
and then install the program. Again make sure
to install it there. The default will usually be the
Startup Volume. A program like Photoshop could
be installed in this manner, but assuming you
don’t have enough RAM, it will need a lot of
scratch disk space. You could install it on your
regular hard drive instead, and configure its
Primary Scratch Disk to be the EZFlyer and
then the secondary to be the normal hard
drive. Keep in mind that the Scratch Disk
should have all of its free space in one con-
tiguous area, so you probably will have to run
Norton Utilities’ Speed Disk to optimize the
disk’s contents.
| BMW ran a on-line contest, I checked off
the electronic Bingo card but then canceled
it. Now whenever there is a lull in my
activity, on or offline, the BMW logo goes
across my darkened screen. I checked in my
System and couldn’t find anything.
Look for CyberDrive and get rid of it. That is
what causes the BMW logo. Don’t assume the
culprit has the letters BMW on it.
| I brought an Illustrator file to someone
else using two floppy disks. Neither disk
would work on his computer, but it worked
on a different computer. Is there any way I
can avoid that?
Your floppy disk drive and the first Mac you
tried it with are out of alignment to each other.
Think of yours as being off center to the left
and the other off center to the right. The
read/write heads on the floppy drive that for-
mats a particular diskette can read the off center
tracks and sectors because that’s where it put
them and they are centered under the heads.
The problem is the other floppy drive’s heads
are in a slightly different position and can’t read
them. You theoretically can have your floppy
drive re-aligned by a service shop but no one
does this. They would just replace the drive
with one that is within specs. The second Mac

Even More Technical Corner
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you tried had an alignment that was closer to
yours, so it could read your floppy.
| I saw the ad for the APS 12x CD-ROM. I
was thinking of replacing my 2x... for that
price ($160 in slimline case) it’s pretty good.
Is it true that CDs are not written to take
advantage of more than a 4x speed drive?
That is true of a CD-ROM with QuickTime
content. They are designed to transfer data at a
given maximum speed and thus a given frame
rate, and will not look any smoother on a faster
mechanism. It’s because most people don’t
have faster drives. A QuickTime designed for
30fps on a 12x CD, which is now rare, would
look unacceptable on the more common 4x CD
drive and take up way too much space of the
CD. On the other hand, any other data CD,
System and application software, clip art,
PhotoCD, non-QuickTime games, atlases, etc.,
will benefit greatly from a faster drive. Your
only potential downside is, if you make your
own, or receive a CD-Recordable CD-ROM
from someone else, you might have more prob-
lems on the faster drives. This is due to the fact
that some people use green dye blanks rather
than the gold/gold variety that should be used.
Kodak’s blanks, used for most Photo-CDs are
gold/gold but other businesses and friends may
be using the troublesome gold/green type. Just
look at the non-label side. If it looks medium
green with a hint of gold, then its a problem. 
| Can I just replace the internal 2x CD-ROM
with the 12x?
No. The old 2x used a caddy and the new one
uses a tray. The plastic bezel would be different.
On your model, you can’t replace the whole
front of the computer, so you would have to
keep the internal CD drive and attach this new
one externally on the SCSI bus as it comes. It
would be advantageous to have two CDs
mounted simultaneously.
| My Preferences folder adds up to about 20
MB because my son has two SyQuests full of
games. Does this slow things down?
The total of your Preferences folder does not
have any special significance other than the
usual taking up space. If you are running ot of
space, and you determine you won’t be playing
those games ever again, then toss the related
Preference files. l

resemble a case of the measles.
Most ink-jet printers can produce images

with scattered dither patterns. This method
avoids the checkerboard affect by placing dots
in a slightly random pattern on the page. At
lower resolutions, this often produces smoother
shading from light to dark with much less
banding – why some gray scale images look
better when printed by a 300 dpi inkjet than

they do when printed by a 300 dpi laser printer.
Beware of Pale shades

Dithering most often fails to produce
pleasing results when significant portions of
your image consist of pale tints that are nearly
white. The printer creates pale shades by
increasing the distance between dots and by
creating pixels that have very little color. The
“few and far between” dots tend to stand out

and get noticed. I recently printed a wonderful
image of Yosemite Falls on Canon’s back print
film. The image fools the you into thinking it’s a
large glossy photograph until you notice the
dither freckles in the clouds and the nearly
white water of the falls.

Some images contain pale shades that avoid
this problem because the color matches one of
the primary colors found in the printer’s ink car-

tridge. While working as a computer sales-
person, I noticed several sample images that
were part of a printer display. The images had a
pale blue background that was extremely close
to the blue (cyan) ink in the printer’s cartridge.
Since a printer can produce this shade with
little white space between the dots, the image
looked great even when printed by a printer that
could only print 150 dpi when printing in color! 

Corel WordPerfect
3.5: character
spacing.
You can control the
spacing between any
pair of adjacent 
characters easily and
precisely by using the
Layout>Kerning…
command. Place the
cursor between the
two letters you wish
to kern, then select
that menu command.

TIP!

Track word spaces 
in QuarkXPress: 
To change the
spacing of word
spaces in a selected
text in QuarkXPress,
hold down all the
modifier keys (Shift-
Option-Command-
Control) and press
the [ key (to tighten)
or ] (to loosen).

TIP!
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Netscape Communicator 4.0, an integrated suite
of tools which replaces Navigator, is more than
just a browser upgrade. In fact, it is so different,
users may not recognize it as Netscape’s work at
first glance.

Most readily apparent is the entirely new
interface. The toolbars look much different
(and they even become transparent when you
reposition them), and is now collapsible. Rather
than taking up a small space at the bottom
right of the browser window, the progress bar
now stretches across the entire screen, behind
the connection status.

Navigator 3.0 ’s triple-frame approach to 
e-mail management has disappeared; messages
are displayed in a separate window now.
Communicator also includes Composer (a visual
HTML editor), Conference (voice and docu-
ment collaboration), and Collabra (group 
discussion). Composer shares the new interface
with the Navigator component, and appears to
be a very competent HTML editor.

What in my opinion is the best new feature
is the ability to create separate user profiles for
people sharing a single computer. For example,
you can use the program for several peoples 
e-mail. On a related note, all of Navigator’s
preference boxes have been merged into a
single window.

What was perhaps the biggest complaint
about the previous Communicator beta was the
high amount of RAM it required: 14 to 16MB
of free memory. That has been much improved;
the current release requires only 10 or 11, or
just 6 with either virtual memory or RAM
Doubler enabled.

We found Communicator to be quite stable
on our test machine (a 132 MHz Power-
Center), although there were some minor bugs
which need to be ironed out. Performance was
on par with Navigator 3.0, but we did run into
several page rendering glitches, which is clear
evidence that this is still beta software.

The final version will ship by summer, for
$59.99 for the standard edition. Though the
price seems rather steep (especially considering
that Microsoft’s Internet Explorer is absolutely
free), the value of the complete package will be
bolstered by the addition of Netscape’s
NetCaster (which is set to debut in the next
preview release). Communicator is an impres-
sive program, and current users of Navigator
should definitely give it a try. l
Netscape Communicator
Processor: PowerPC or 68K
Version: Preview Release 3
– by Oliver Dueck 

Netscape Communicator 4.0

UPS and Downs
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If you have a low resolution printer, follow the
directions in the printer’s manual to print a test
pattern to get samples of your printer’s cyan,
yellow and magenta inks. Then use those colors
as much as possible when creating graphics
with a paint or drawing program.

When you work with scanned photographs,
you can sometimes reduce the dither freckles
by filters and various adjustments to make

white areas truly white.
Use Colored Papers Carefully

Since color printers create a particular
shade by dithering between the previously men-
tioned pixels and the white background of the
paper, printing on colored papers totally disrupt
the printer’s ability to accurately reproduce the
colors you have created on the screen. Thus, it’s
almost impossible to reproduce color photos on

anything but bright white paper.
You can use colored text or line art with fairly

good success if you keep in mind the effect of
mixing the paper’s color with the colors of your
graphic. You may be able to approximate the
effect, by placing a partially transparent layer of
the same color as your paper on top of your
graphic. (Be sure to remove this layer before
printing.) Keep in mind that dark colors, with

little space between pixels, will be less affected
than pale colors.
Conclusion

Learning how your printer dithers can help
you get the most out of its capabilities.l

Want to make an
invisible folder?
In any painting 
program draw a plain
white square larger
than an icon. Select
and copy it. In the
finder make a new
folder (Command-N).
Select the folder,
choose Get Info
under the File menu.
Click on the folder
icon to select it and
paste. The folder 
disappears.

If you really want
the folder to be
undetected by family,
friends or co-workers,
change the file’s
name to a blank
space. The file will
still be there but be
completely invisible.
If you lose it, just
change the View to
By Name and it will
show up usually at
the top of the list.
Do you use your
Calculator at all? 
I do, and often. And I
was frustrated by the
fact that if I hit a
wrong number any-
where in the calcula-
tion I couldn’t delete
or clear just that
wrong number but
had to start over.
Then I found out that
if I used the Note Pad
and typed in my
equations, such as
.07*5500/4=, on the
Note Pad, then
copied it and pasted
it into the Calculator,
I got an instant
answer.
–Bea Burns

TIP!
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Keep folders open
on the Desktop:
Have your favorite
folder(s) open on the
desktop whenever
you start your Mac:
just place an alias of
each folder you want
to appear in the
Startup Items folder
in your System
Folder. When you
start up, you’ll find a
window giving you
immediate access to
the contents of the
folder(s).

TIP!
Why is it necessary to protect a Mac from the
ravages of the utility company and Mother
Nature? Macs are designed to run on 110v AC
current and are often plugged into phone line
as well. Both are sources of voltage spikes,
power surges, and other interruptions that can
be caused by solar flares, lightning, or line 
failures. A computer and monitor could be
damaged by either of them The cheapest insur-
ance is use of a power strip with surge/spike
protection. These devices short out voltage
spikes and power surges. In a worst case 
scenario, the device will sacrifice itself in order
to protect the equipment that is plugged into
it. (Mine went up in smoke as I was using my
computer.) Don’t forget to place protection on
your phone line as well. Some surge boxes are
available with individual line switches and

phone line jacks. I lost a modem and answering
machine when its circuits were damaged by
lightning. While more expensive, the best 
protection is to use an Uninterrupted Power
Supply (UPS) battery backup power supply.
MacOS doesn’t like to be interrupted by a
power failure. Worse yet, should this interrup-
tion occur while you are installing software, or
saving a datafile, your hard drive could become
so scrambled that you may be forced to
reformat it. The UPS will protect your com-
puter from interruptions giving you time to exit
from the application and shut down properly.
UPSs with Local Area Network (LAN) systems
are available for file servers and personal 
computers allowing the user to shut down if
the power is interrupted for an extended length
of time. l

STARTUP ITEMS
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If another reason is needed to inspire the
middle age (over 50) group to go on-line it is
at URL http://www.old-time.com/. This is the
gateway to the days when radio ruled. The
practitioners were clever, inspired people who
could make you laugh, cry or scare the hell out
of you, a la Orson Welles. THE NEW YORK
TIMES (Sunday, June 8) had a feature article on
this subject as well as the URL given above. I
accessed the Old Time Radio (OTR) site and
found it absolutely fascinating. It is about the
easiest site to navigate, offering rapidly down-
loadable radio theme music not available any
where else. Of course your Mac needs the
appropriate audio software, available free online
or from the LIMac Public Domain Library.
There is also a bulletin board where people,
young and old, are immersed in old time radio
ranging from As The World Turns and The
Abbott and Costello Show, to Red Skelton or
Bob Hope. Try it, you’ll like it.

On Saturday, June 14, we, along with Bill
Medlow, attended the tenth anniversary
meeting of the Intergalactic User Group
Conference. The purpose of the conference was
to offer an opportunity to computer user
groups to share their problems and solutions.
User groups throughout the U.S., Canada and
even Australia were represented as prizes were
awarded for best newsletter, best website and
best informational flier. LIMac was awarded the
certificate for the latter, thanks to our graphic
design committee. The site, to be visited by all
user group internet surfers is http://apcug.org.
It has links to all user groups on Long Island
including LIMac, and the world. The benefits
to be obtained from sharing similar problems
and various solutions are too numerous to
detail here, but be sure to check out this site. l

User Group Connection
This year’s Boston MacWorld Expo will take
place August 6-8. July 7 is the deadline to 
pre-register. Admission to the half-day tutorials,
conference sessions, exhibits and keynote ses-
sions is $170 ($195 at the door). Admission to
the exhibits only is $25 ($40 cash at the door).
To get information and/or a registration form
by fax call 800-645-EXPO. You can also access
their web site at http://www.mha.com/mac-
worldexpo/ Be sure to visit the UGWUMP
Room (User Group Welcoming Unwinding
Meeting Place Room) when you are at the
Bayside Convention Center. It is a nice quiet
place for user group members to relax and
unwind before going out onto the convention
floor once again. Also, this is where Mac users
come to meet and trade ideas. 

People from the User Group Store will be
there to answer questions and give a presenta-
tion. Power Computing will supply computers
that will be set up with Internet access so you
can check your e-mail. Scheduled sessions and
meetings will be held there for all three days
during the Expo. It will be interesting to see
how many vendors will participate in this year’s
Expo. Keep in mind that many companies
opted not to participate with Apple in this
year’s PC Expo that was held at the Javits
Center. It seems to me that Apple must
encourage and promote the participation of
vendors in certain key areas such as business,
education, graphics and desktop publishing. A
poor showing at the Boston Expo, will only
tend to add fuel to the fire for the critics of the
Macintosh. None of us wants to see the Mac go
the way of the Amiga. Oh yes, if Apple wants to
have any credibility with users and the business
community, It had better deliver Mac OS 8, this
July, as promised. l

Helen and
Sheldon Gross
SHEL1@cybernex.net

Max Rechtman
MaxLIMac@aol.com

Better Drop
Shadows: 
In Photoshop, you
can make your drop
shadows more real-
istic by running the
Diffuse filter a few
times on the shadow
layer only. This adds a
random noise pattern
to the edge of the
shadow.

TIP!

Sore Eyes

Lots of demonstrations at
the LIMac meeting on Friday,
July eleventh at seven P.M.


